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Word 2003  Introduction 

 
Launching Microsoft Word and Creating a New Document 
 
To Launch from the Start Menu: 
 
• 
• 
• 

Click on Start in lower left corner on task bar. 
Choose Programs from the Start Menu. 
Choose Microsoft Word.  This will create a new, untitled document. 

 
 
Touring the Word Window 
 
• 
• 

• 

The Title Bar – The Title Bar displays the name of the current document. 
The Menu Bar – The Menu Bar provides tools to use with Word to create and format 
documents.  

 

 
 

The Tool Bars – The Tool Bars contain commands in button form that are also found in the 
Menu Bar.  The Standard Toolbar and Formatting Toolbar are the two most commonly used 
toolbars in Word. 
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Note:  To see the name of a button on a toolbar, place the mouse pointer over the button.  A label 
will appear identifying the name of the button. 
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• The Task Panes - The task panes in Office 2003 provide information about important tasks 
at a glance and easy access to important features such as templates and formatting. 
Features and tools previously hidden in menus and toolbars are now accessible on-screen 
with one click. For convenience, the task pane appears automatically on the right side of your 
screen. The selection can be made to show, hide, or move a task pane when working in 
Word. The task pane can be docked on the right or left side of the screen or it can be 
dragged to any location. Navigate through available panes by clicking on the left and right 
arrows on the task pane menu bar or by clicking on the drop down arrow. 

 
The following illustration shows a Word document in Print Layout View with the New 
Document task pane open. To access Print Layout view, choose View on the Menu Bar, 
and then choose Print Layout. If the task pane is not visible, open it by choosing View on 
the Menu Bar and selecting Task Pane.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following task panes are a sample of what is available in Word 2003: 

New Document Task Pane      
 

• On the New Document task pane, you can select to open the following: 
• Other documents created in Word. Word 2003 will open Word XP, and 

Word 97. 
• A new blank document 
• A new blank Web page 
• A new blank e-mail message 
• A new document from an existing document 
• A Professional Fax 
• A general template 
• Templates from the Microsoft Site 
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Insert Clip Art Task Pane 
 
 
Upon selecting Insert Clip Art from the menu bar, the Insert Clip Art Pane opens 
providing the following options: 
 

• Search for specific clip art 

• Search for clip art from various collections 

• Search for specific media 

• Insert clip art using the Clip Organizer 

• Insert from Clips Online 

 
 
 
Reveal Formatting Task Pane 
 
 
With text highlighted, select from the following options on the Reveal 
Formatting task pane to review selection windows:  
 

• Font 

• Language 

• Alignment 

• Indentation 

 
 
 
 

• 

• 

The Horizontal and Vertical Scroll Bars - The Scroll Bars are used to move through 
documents that are longer and wider than the viewing area of the screen.  The vertical scroll 
bar is located to the right of the document window.  The horizontal scroll bar is located at the 
bottom of the document window 
The Status Bar - The Status Bar is found at the bottom of the Word window.  This bar allows 
the user to see important information about the document such as the current page number, 
the number of pages in the document, and the current location of the cursor. 

 

Scroll bars 
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Scrolling Through a Document with the Mouse 
 
• 
• 
• 
• 
• 
• 
• 
• 

To scroll up one line, click the up scroll arrow.  
To scroll down one line, click the down scroll arrow.  
To scroll up one screen, click above the scroll box.  
To scroll down one screen, click below the scroll box. 
To scroll to a specific page, click and drag the scroll box.  
To scroll left, click the left scroll arrow.  
To scroll right, click the right scroll arrow.  
To scroll up or down one page, click the Select Browse Object button  on the vertical 
scroll bar, and then select browsing method.  

 
 
Selecting Text by Highlighting 
 
To highlight text: 
 
• 
• 
• 
• 

• 

• 

• 

• 

• 

• 

Place the mouse to the left of the text that is to be highlighted. 
Click and hold the left mouse button down. 
Drag the mouse over the text to be highlighted. 
Text will be highlighted or shaded in black. 

 
To highlight large portions of text in a document: 
 

Shift + Ctrl + Home will highlight all text from the point of the blinking cursor up to the 
beginning of the document.  It will not highlight any text past the blinking cursor. 
Shift + Ctrl + End will highlight all text from the point of the blinking cursor down to the end of 
the document.  It will not highlight any text before the blinking cursor. 
Ctrl + A will highlight all text in the document. 

 
To highlight a single word: 
  

Double-click the left mouse button on the word.  
 
 
To highlight a sentence: 
 

Hold down the CTRL key and then, using the left mouse button, click anywhere in the 
sentence.   

 
To highlight a paragraph: 
 

Triple click with the left mouse button anywhere in the paragraph.   
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To highlight multiple lines of text: 
 
• Place the pointer to the left of the line until it changes to a right-pointing arrow; click the left 

mouse button and then drag up or down. 
 
 
Using the Edit menu to cut text 
 
• 
• 

Highlight the text to be cut. 
Choose Edit on the Menu Bar. 

• Choose Cut.  The text will be removed from the document. 
 
Other methods for cutting text: 

• After highlighting the selected text to be cut, the keyboard strokes Ctrl +X will cut the 
text.   

• After highlighting the selected text, click the Cut button on the Tool Bar.   
• The Backspace key will delete text prior to the cursor.  
• The Delete key will delete text after the cursor. 

 
 
Using the Edit menu to copy text 
 

• 
• 

Highlight the text to be copied. 
Choose Edit on the Menu Bar. 

• Choose Copy.  The text will be copied and available for placement elsewhere in this or 
another document.  

 
Other methods for copying text: 

• After highlighting the selected text to be copied, the keyboard strokes Ctrl + C will copy 
the text.   

• After highlighting the selected text, click the Copy button in the Tool Bar.   
 
 
Using the Edit menu to paste text 
 
• 
• 

Place the cursor at the appropriate point to paste the cut or copied text. 
Choose Edit on Menu Bar. 

• Choose Paste to place the text in document. 
 
Other methods for pasting text: 

• After placing the cursor at the desired point for the text to be inserted, the keyboard 
strokes Ctrl + V will paste the text.   

• After highlighting the selected text, click the Copy button in the Tool Bar. 
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Copy and Paste Multiple Items to and from the Clipboard 
 
 

• 
• 
• 

• 

• 

Cut or copy the first section of text to be pasted. 
Cut or copy the next section of text to be pasted.   
The Clipboard task pane will appear. Up to twenty-four items, 
including graphics can be copied to the clipboard.  
To paste all the items from the Clipboard:  Click where items are to be 
pasted.  Then, click on the Paste All button located on the upper-left 
side of the Clipboard pane. 
To paste one item at a time from the Clipboard:  Click where the item 
is to be pasted.  Then, Click on the text/object on the clipboard to 
paste it into the document. 

 
 
 
Changing Fonts, Font Size, and Font Style 
 

• 
• 

Highlight the text for which the font is to be changed. 
Choose Format from the Menu Bar. 

• Choose Font.  The Font dialogue window will appear.  
• Scroll through the list of fonts.  When a Font is selected, a preview of the font will appear in 

the preview pane. 
• Choose OK when a Font has been chosen. 
 
 
Note:  Font Style, Font Size, Underline, Color, and Effect may also be selected through this 
same method.  The Format Tool Bar is another method that can be used for changing these 
elements in a document.  After the text is selected, the font can be changed by scrolling through 
the Font box; the font size can be changed by scrolling through the Size box; and the font style 
can be changed to bold by choosing B on the Tool Bar, changed to italic by choosing I on the 
Tool Bar, and underlined by choosing U on the Tool Bar.  
 
 

 
Use the Reveal Formatting task pane to format text. 
 

 

Tip 
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Changing Alignment 
 

• 
• 

Highlight the text for which the alignment should be changed. 
Choose Format from the Menu Bar. 

• Choose Paragraph. The Paragraph dialogue window will appear. 
In the Alignment box under the Indents and Spacing tab, choose the desired alignment of 
left, centered, right, or justified.  A preview will appear in the preview pane. 

• Choose OK when the desired alignment has been selected. 
 
Note:  Another method of changing the alignment is to select the text, then choose the proper 
Alignment buttons on the Formatting Tool Bar.  
  

 
 

 

Tip Alignment and Indentation may also be selected by using the Reveal 
Formatting task pane.  
 

 
Inserting Bullets and Numbers into the document 
 

• 

• 
• 
• 

Place the cursor in front of text to be bulleted or numbered or at the point in which a bulleted 
or numbered list should begin. 
Click the Bulleted list button on the Tool Bar to insert a bullet.   
Click the Numbered list button on the Tool Bar to insert a number. 
To promote or demote the bulleted or numbered list, click on either the Promote or Demote 
buttons to the right of the Bulleted list button on the Tool Bar. 

 

 
 
Using Undo and Repeat Actions 

To undo any action: 

• Choose Edit on the Menu Bar. 
• Choose Undo.  
 
Other methods for undoing an action: 

1. Use the keystrokes Ctrl + Z to repeat an action. 

2. Click the Backward Pointing Arrow on the Tool Bar to undo an action.  
 
To repeat an action: 
• Choose Edit on the Menu Bar. 
• Choose Repeat. 
 
Other methods for repeating an action: 

1. Use the keystrokes Ctrl + Y to undo an action. 

2. Click the Forward Pointing Arrow on the Tool Bar to repeat an action.  
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Using Spell and Grammar Check  
 
To correct a spelling or grammar error: 
 
• Choose Tools from the Menu Bar. 
• Choose Spelling and Grammar.  A dialogue box will appear.  The top pane in the dialogue 

box explains the problem with the word or sentence.  The bottom pane offers suggestions. 
 

 
 
 

 
 
 

 

• Choose Ignore, Ignore All, Next Sentence, or Change. 
 
Other ways to check spelling and grammar in a document: 

1. Press function key F7 on the keyboard to conduct a spelling and grammar check of 
the document. 

2. Click the ABC Check button on the Tool Bar. 
3. The red wavy lines that appear in a document indicate possible misspellings.  Right 

click the mouse on the word and options for that word will appear.  The green wavy 
lines that appear in a document indicate possible grammar errors.  Right click the 
mouse on the word or phrase and options for correcting the grammar errors will 
appear.  
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Saving a Document 
 
 
To save a new, unnamed document: 
 
• Choose File from the Menu Bar. 
• Choose Save. 
• Name the document in the File name box. 
• Choose Save. 
 
 
 
Note:  After the document has been named and saved, it is a good idea to save often while 
working on a document.  This can be done three different ways: 
 

1. Choose Save under File in the Menu bar. 
2. Click on the Disk button in the Tool Bar. 
3. The keyboard strokes Ctrl + S will also save the document. 

 
 
To save a document with Save As…: 
 
• Choose File from the Menu Bar. 
• Choose Save As. 
• Give the document a new name in the File name box. 
• Choose Save. 
 
 
Using Page Setup for Setting Margins and Orientation 
 
• Choose File from the Menu Bar. 
• Choose Page Setup. 
• To change margins, select the Margins tab in the Page Setup dialogue box. 
• From this dialogue box, the Top, Bottom, Left, and Right margins can be changed. 
• After making the changes, choose either Whole document or This point forward in the 

Apply to box.  Choose OK. 
• To change paper orientation, select either Portrait or Landscape. 
• To change paper size and paper orientation, select the Paper Size tab in the Page Setup 

dialogue box. 
• To change paper size, click on the triangle beside the Paper Size box.  Select a size. 
• After making the changes, choose either Whole document or This point forward in the 

Apply to box. 
• 
• 

Choose OK. 
Margins can also be set up using the Section feature found in the Reveal Formatting task 
pane. 
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Printing and Previewing a Document 
 
To print a document from the Menu Bar: 
 
• Choose File from the Menu Bar. 
• Choose Print. 
• 

• 

Choose OK to start printing document. 
 
Note:  There are two other methods for printing a document. 

1. Use the key strokes Ctrl + P. 
2. Click the Printer button on Tool Bar. 

 
 
To preview a document: 
 

Choose File on Menu Bar. 
• Choose Print Preview. 
• Choose Close to return to Normal View. 
 
Note:  Another method for previewing a document is to click the Page with Magnifying Glass 
button on Tool Bar. 
 
 
Using Microsoft Word Help 
 
To use the Office Assistant: 
 
• Choose Help from the Menu Bar. 
• Choose Microsoft Word Help.  The Office Assistant appears and asks, “What do you want 

to do?”  Follow the onscreen directions. 
 
Note:  The function key F1 will also display the Office Assistant. 
 
 
To use Contents and Index: 
 
• Choose Help from Menu Bar.   
• Choose Contents and Index. 
• 
• 

Select either the Contents or the Index tab. 
Follow the on screen directions. 

 
 

Use the new help box located on the right side of the menu bar. 

 

TIP 
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Adding Clip Art 
 

Adding art is an easy way to provide illustrations that support research and report concepts. With 
Office 2003, the user can browse, add, and organize clip art from any Office program and store the art 
in the Clip Organizer. It is possible to search for media files based on descriptive keywords, file name 
and format, and clip collections.  

Steps for Inserting Clip Art 
 

• 
• 
• 
• 
• 
• 
• 
• 
• 

• 

• 

• 
• 

• 

• 

• 
• 
• 
• 

• 

Choose Insert from the Menu Pane. 
Choose Picture. 
Select Clip Art to access the Microsoft Gallery. The Insert Clip Art Task Pane will appear. 
Click in the Search text box and type picture name. 
Click the Search button. 
A series of graphics will appear related to the requested search. 
In your document, position the cursor to set the location for inserting the picture. 
Click on the picture selection or use the drop-down menu for the graphic and click Insert. 
When the graphic is inserted into the document, it can be sized by clicking on one of the 
sizing handles (small black boxes) and then moving the graphic either in or out to the desired 
size.  
Align the picture to the left, center, or right using the alignment buttons on the formatting tool 
bar. 

 
 
Moving Graphics  
 

To move the graphic freely about the document, right click on the graphic and select Format 
Picture. 
Click on the Layout tab and select a choice other than In line with text. 
Once this is done, hold the left mouse button down and move the graphic to the desired 
location.  The sizing handles will now be small white boxes. 
To resize the graphic, click on one of the sizing handles of the graphic (the small square 
boxes) and move the graphic either in or out to the desired size. 
To move the graphic, click and drag picture to desired location. 

 
 
Inserting Pictures from File 
 

Choose Insert from the Menu Bar. 
Choose Picture. 
Select From File to insert pictures from files on the computer. 
Once the graphic is inserted into the document, it can be manipulated by right clicking on the 
graphic and selecting Format Picture. 
Follow the steps listed above to allow free movement of the graphic within the document. 

 

 13



Word 2003  Introduction 

Inserting a Table 
 
• 
• 
• 
• 
• 
• 
• 
• 

Choose Table from the Menu Bar. 
Choose Insert. 
Click on Table… 
Set the number of rows and columns. 
Click OK. 
Use the tab key to move from cell to cell. 
Click and drag on the borders of the cells to resize them. 
Tab after the last cell to add a new row or use Insert in the Table menu. 

 
 
Adding Page Borders 
 
• 
• 
• 
• 
• 
• 

Choose Format from the Menu Bar. 
Choose Borders and Shading… 
Click on the Page Border tab. 
Select a border setting. 
Select style, color, width, and/or art. 
Click OK. 

 
 
Displaying Additional Toolbars 
 

• Choose View from the Menu Bar. 
• Choose Toolbars. 
• In the submenu, click on the name of the toolbar to display it.  Toolbar names with check 

marks next to them are already displayed. 
 
 
Moving Toolbars 
 
Moving a docked toolbar: 
 
A docked toolbar is one that is attached to one edge of the program window. 

• Click on the move handle  and drag the toolbar to the desired location within the document 
window.  The toolbar is now called a floating toolbar. 

 
Note:  This picture displays two toolbars docked side by side. 
 
 
Moving a floating toolbar: 
A floating toolbar is one that is not attached to the edge of the program window. 
 
• 
• 

Move the toolbar by clicking and dragging on its title bar. 
Dock the toolbar by dragging it to one of the edges of the program window or double click on 
its title bar. 
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Note:  This picture displays one docked toolbar and one floating toolbar. 

 
 

 

Standard Toolbar Docked
Move handle 

Formatting Toolbar floating 

 
The Drawing Toolbar 
 
The Drawing Toolbar has many tools to use to create objects.  Below are directions to just a few.  
This toolbar is fun to learn by experimenting with the different tools. The Drawing Toolbar is 
usually docked at the bottom of the Word window. If the Drawing Toolbar is not visible, select it 
from the Toolbars option under the View menu. 
 
Rectangle and Oval Tools: 
 

Click on the Rectangle tool . • 
• 

• 
• 
• 
• 

Place the crosshair + on the document where the upper right corner of the rectangle is to 
begin. 
Hold down the left mouse button and drag the mouse diagonally and down to the right. 
When the rectangle is at the desired size, release the mouse button. 
To change the size of the object, left click on one of the eight sizing handles and drag. 
To create an oval, click on the Oval tool and then follow the directions above. 
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Note:  To create a perfect square or circle, hold down the shift key while dragging.   Use other 
tools such as Fill Color, Line Color, Font Color, and Line Style to customize the drawing object. 
 
Line and Arrow Tools: 
 
• Click on the Line tool . 
• 
• 
• 
• 

• 

Place the crosshair on the document where the line is to begin. 
Hold down the left mouse button and drag the mouse the direction the line is to go. 
When the line is the desired length, release the mouse button. 
To create an arrow, click on the Arrow tool and follow the directions above.  The arrow will 
appear at the end of the line when the mouse is released. 

 
Note:  To create a straight line or arrow, hold down the shift key while dragging. 
 
WordArt Tool: 

Click on the Insert WordArt tool . 
• The WordArt Gallery dialog box will appear. 
 

 
 

• 
• 

Click on the desired style and then click OK. 
The Edit WordArt Text dialog box will appear. 

 

 
 
 

• 
• 

Click on the words “Your Text Here.”  When the cursor appears type the text. 
When finished typing, click OK. 
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